Purchasing:
Change Orders

Internet Native Banner 7x « Finance Module
Release Date: July 27, 2006

@ FERRIS STATE UNIVERSITY
lmagi_ne Movre



Table of Contents

Conventions Used in this Manual............ccoiiiiiiiiii e 1
Creating 8 Change OFder ........uuii i 2
Change Order Header Information BIOCK.............ccueeeiiiiiiiiiiiiiiie s 3
Vendor INformation BIOCK ...........cooiiiiiiiiiiieeee e 5
Commodity/Accounting BIOCK..........ccooiiiiiiiiiiie e 7
Completing the Change Order ...........coooviiiiiiiiiieiie e 9

Document Change LOg ..cccooveiiiiiiiieee ettt 10



Purchasing: Change Orders « Conventions Used in this Manual « 1

Conventions Used in this Manual

The following formatting conventions are used throughout this manual.

Convention Example

Text entry is printed in monotype (Courier) font. | Type FPAREQN in the Direct Access field.
Field names are in bold face. Type 299771111 inthe ID field.

Button names are in bold face. Click the Execute Query button.

Specific block names (but not “Key Block”) are | In the Addresses block, click inside the Zip

in bold face. Code field.

Form names are in all capital letters. Navigate to the FPAREQN form.

Keyboard keys are in all capital letters. Press ENTER.

Menu navigation is listed as To count the query hits, choose Query > Count
Menu > Menu Option. Hits.
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Creating a Change Order

g

The Change Order Form (FPACHAR) is used to revise header, commodity, and
accounting information on a completed, approved, and posted purchase order.

There are some important exceptions when you revise purchase order
information using the Change Order Form. You cannot change the Vendor, the
Document Level Accounting indicator, or Currency Code with a change order. In
addition, you cannot change:

e Expense Purchase Order to a G/L Purchase Order or vice versa.

e Regular PO to an Open PO or vice versa.

1. Go to the Change Order Form (FPACHAR).

File Edit ©ptions Block Itemn Record Query Tools Window Help

BOE REEE 9 ZEE QI EIEEE S @)X

"mChange Order FRACHAR 7.1 [TRNG) [0

Purchase Order: B Blanket Order: EI change Sequence Number:

Screen 1: Change Order (FPACHAR) form

2. Inthe Purchase Order field, type the number of the purchase order you
want to revise. Use the Down Arrow to search for purchase orders.

3. Leave the Blanket Order field blank. FSU is not issuing Blanket Orders, so
this field should always be blank.

4. Inthe Change Seq # field, type NXT for Banner to generate the next
available change sequence number. If you want to access an incomplete
change order, type that change sequence number in this field.

File Edit Cptions Block Itern Record Query Tools wWindow Help

BOE BRAEE T REHE &S E

%Ehange Order FPACHAR 7.1 (TRMG) -I-0

[ 1@ |

Purchase Order: 900017?3[2‘ Blanket Order: E Change Sequence Number: |HxT

Screen 2: Completed Change Order (FPACHAR) form

NOTE: You cannot generate a new change order sequence number until you
complete, approve, and post any previous change orders.

5. Next Block
...OR...
On the Options menu, click Document Information to go to the
Document Information form.
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Change Order Header Information Block

A copy of the current header information defaults into this window; you may
update the fields as necessary.

78 Change Orderi Docurnent Information FPACHAR 7.0 (TRNG) «0ielleelelelelelfel il el el e e e e e oo e

Purchase Order: POOOL773 Blanket Order: change Seq: ’F
Order Date: 20-cep-200s ] Transaction Date: [16-DEC-2005 |5
Delivery Date: ’m@ Comments: ’7
Commodity Total: 5,154,350 Accounting Total: 5,184,950
Change Accounting Only Purchase Order Type: |[Regular
Original Document Text: |Copy Docurnent Text v|
Buyer Code: |SCM E |Sand\,l Morningstar
Blanket Order Termination Date:'ir@
v NSF Checking Deferred Editing
Origin: [panner

Reference Number: |

Screen 3: Change Order: Document Information block

1. The Purchase Order date field represents the date associated with the
change order. This should be changed to the current day date. The purchase
order date from the original purchase order remains unchanged.

2. The transaction date (shown in the Transaction Date field) is a required field
that determines the fiscal period. It defaults to the system date, but also
should be changed.

3. The delivery date defaults from the PO, but can be changed. This date must
be equal to or great than the Transaction date.

4. Do NOT check the Change Accounting Only checkbox — document will not
route correctly for approvals when checked.

5. Verify the option selected in the Original Document Text field; change if
necessary.

NOTE: View existing document text on FOAPOXT. To do this press F5, then
type FOAPOXT in the GO: box and press ENTER. Close FOAPOXT when
complete to return to FPACHAR.

6. On the Options menu, click Document Text to enter any required document
text. Use either printing or non-printing text to record what is being changed
and why.

If the Change Order will be submitted to the vendor, be sure to use
Document text to clearly explain what is being changed. Use non-printing text
for internal changes, for example, accounting distribution changes.

7. The Buyer Code is a required field and defaults from the PO. Do not change
this field.

8. Leave Blanket Order Termination Date field blank.
This is for Blanket Orders, which FSU is not using.
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9. The Rush Order checkbox is disabled.
FSU is not using Rush Order features.

10. The NSF Checking checkbox will default as checked. DO NOT CHANGE.
(Banner security will not allow you to change this field, but an error does not
display until completion and may cause document to suspend.)

11. The Deferred Editing checkbox will default as unchecked. DO NOT
CHANGE. (Checking deferred editing is similar to batch processing and will
prevent the system from displaying error messages).

12. Next Block to verify the Requestor, COA, Organization, Email, Phone,
Fax, Ship To and Attention To fields. Make changes as required.

%= Change Order: Reques livery FPACHAR 7.1 (TRNG) -

Purchase Order: |PO0O0L773 Blanket Order: Change Seq: |MXT
Order Date: 16-DEC-2005 @ Transaction Date: |18-DEC-2005 @ [J1In Suspense
Delivery Date: ’m@ Comments: ’7 [JDocument Text
Commodity Total: ’m Accounting Total: ’m

Requestor: draer| COA: |1—E||Ferris State Big Rapids
Organization: [z9200  [#]/survaying Email: [szotark@fanis edu

Phone: ,FW Extension: ’7 Fax: 'F’m Eutensiun:’—
ship To: swutin [¥]

Street Line 1: |academic Technology Services

Street Line 2: |915 Carnpus Dr SWH 110

Street Line 3: |

Building: Floor:

City: Big Rapids

State or Province: IT ZIP or Postal Code: |49307-2291

Nation: |united states

Phane: [z21 | [se12899 Extension: | |

Contact: |Scntt Thede

Attention To: [seott Thede

Screen 4: Change Order: Requestor/Delivery block

13. Next Block to verify vendor information.
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Vendor Information Block

The Vendor number and name fields default and may not be changed. You can
enter and change information in both the vendor Address Code and Seq #
fields, but the combination of these fields must be valid for you to save the

record.

" Change Order: Yendor FPACHAR 7.1 (TRNG) -

Purchase Order:

[paoire3
[te-oec-2005 (59
Delivery Date:  [16-DEC-2005 (o]
Commodity Total: 5,184,990

Order Date:

Blanket Order:
Transaction Date: [L&-DEC-2003 ()

Comments:

Accounting Total: 5,184,90

cChange Seq: |HWxT
[J1In Suspense

[ pocument Text

Yendor:

Address Code:

|12002695 |De|\ Marketing LP

[ [*] sequence Number: [ 1[¥]

Street Line 1: |one pall way

Street Line 2: |D0 Box 8711

Street Line 3:
Round Rock
=

City:
State or Province:
Telephone:

Fax Mumber:

ZIP or Postal Code: |73632-0325
500 | |2747793  Extension:
800 | 3655323 Extension:

Email:

[ Disbursing Agent

Nation: [

Contact: [paminick Fiarez
Discount: IETE”Nat 30 Days

FOB Code: [or [7][pestination Prapay
Tax Group: =)l

Class Code: =]

Carrier: [ =
Currency: [

Screen 5: Change Order: Vendor block

1. Verify address, discount, and FOB Code. Change if necessary.

the new order.

ﬁ If you change the Discount Code, the system adjusts all items automatically for

2. Next Block to view the Purchase Order Item Selection (FPQCHAP) form

(Screen 6).

The Purchase Order Item Selection form lists the items from the original
order — all items MUST be selected and brought into the Change Order.

Purchase Order: |PO0O01773

Clchange all

Blanket Order:

Change Sequence Number: 1

vendor: [12002695 [Dell Marketing LP

Purchase Commodity
Order Item Code

——
—
——
—

JTTTI

Purchase Drder Commodity Information

20454 Latitude DE10 Intel Pentium
20454 QptiPlex GX280 Intel Pentium

suEy
o* LN

Line Item Text .' *
ExistsCopy Option USM  Units UnitPrice &  Added

W ‘Ignm’e v‘ ’?l 2.00 ‘ 1,970‘7600: " —— :
|rT [1anore ~| ’? [ 100 | 1,443.3800y F "
L[ ) [ \ O]
0 =3 | *eo 0 Jof
[ | [ \ ek
L ] LI \ O

[] I \ o

Screen 6: Change Order — Item Selection (FPXCHAP) form
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3. Check the Added box for all line items to bring them into the Change
Order document, including any item text; or

r?gpum izl e SEleEimn [{REEllE P Bl e e b b e B e e B e P P B e P P P B e P P e e P P e e P e
Purchase Order: 0001773 Blanket Order: ’— Change Sequence Number:’—l
( i vendor: |1z00z695 [pell Marketing LP

Purchase Order Commodity Information

Purchase Commodity Line Item Text

Order Item Code ExistsCopy Option UfM Units Unit Price Added

1 20454 Latitude DE10 Intel Pentiurn W ‘Ignnra v| |T ‘ 2.00 | 1,670,7600 O [
2 [2o4sa OptiFlex GX280 Intel Fentium W] [rgnere =] [ea || 100 | 1,443.3800 O
O | | [ | 0
N | [ | 0
0 | [ | B
[] [ | [ | =
U | | [ | =
0 | [ | 0
0 | [ | B
[] [ | [ | =
U | | [ | =
O | [ | m
O [ | [ | 0
[] [ | [ | =
U | | [ | =
O | [ | m
O | | [ | 0
(] ] | 0
RLCLLLCEEEEEEEEEEEEEEELEEELE LT Fes
>.“ Check to include allilems without text Press SAVE to copy,  ‘a
% | Record: 111 | | | o |=08C-

.
" amssssssssssssEsmEEsmmEnEnmnnnn®

Screen 7: Change Order - Item Selection (FPQCHAP) form

4. Check the Change All checkbox; this will bring all items into the Change
Order without Item Text.

5. Press F10. Message box will appear confirming records were saved.
Click OK.

6. Click the Exit button to go to the Commodity/Accounting Information
block.
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Commodity/Accounting Block

Use this block to revise the commaodity information. All of the commodity and
accounting information has carried forward from the Purchase Order and is
populated on the Change Order (FPACHAR) form.

At this point, you can:
e add new items to the order
e update pricing and/or quantities to existing items
e remove a line item by changing its unit price to O (zero)

When ever changes are made to a line item, be sure to tab thru all of the fields
for that item, this will allow Banner to recalculate the new totals.

"e5 Change O

Purchase Order: [FO001773 Blanket Order: Change Sequence Number: ,17

order Date: [16-pEc-2005 | Transaction Date: [16-DEc-2005 [C1n Suspense
Delivery Date: |16-DEC-2005 ¥ Document Accounting M Document Text

Item usM Tax Group Quantity Unit Price Extended Cost
[T o 2 7] = [ z X 1,870,7600 = [ aaas
Cnmmndity[zl Description E Discount Amount: ‘ .00
|Lat\tude D&10 Intel Pentium [Ceommodity Text Additional Amount: .00
[204s4 [optiplex @280 Intel Pentium [litem Tent Tax Amount: ’7.00
[ [ [ Add Ccommadity Commodity Line Total: [ srasz
[ [ v Distribute Document Commodity Total:| 5,184,590
FOAPAL - NSF--- o usb

[ aler[ 2 R L 1 SR [ override [ Extended [ saisasq
COA Year Index  Fund Orgn Acct Prog Actv Locn Proj [JSuspense [ piscount .00
[=] = = =] 2| = = & = [ additional 00
[17 [os ] [20600  [[as1o0 7159 223 [ [ [ Mrax .o
|— ’_‘ ‘ ‘ | ‘ ‘ | | FOAPAL Line Total: 5,184.90
r ,7‘ ‘ ‘ | ‘ ‘ | | Document Accounting Total: 5.184.90

Screen 8: Change Order - Commodity/Accounting block
1. Highlight existing line item requiring changes, or next record (arrow down) to
a blank line to add a new line item.

2. For new line items, enter a commodity code and description; or edit
description if needed for an existing line item.

3. The U/M field is required. For new line items, the unit of measure defaults
from the commodity and can be changed if it is not correct for this purchase.

4. You may enter or modify the information in the Quantity and Unit Price
fields. The extended amount is calculated automatically.

5. The system calculates the discount amounts based on the terms from the
Vendor block.

If you are using commodity level or document level accounting and you have the
Distribute checkbox checked, the form will automatically distribute your
commodity changes in the appropriate manner. To make changes manually,
uncheck the Distribute checkbox.
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6. Next Block to go to Accounting information.

"e5 Change O
Purchase Order: [FO001773 Blanket Order: Change Sequence Number: ,17
order Date: [16-pEc-2005 | Transaction Date: [16-DEc-2005 [C1n Suspense
Delivery Date: |16-DEC-2005 ¥ Document Accounting M Document Text

Item usM Tax Group Quantity Unit Price Extended Cost

1 o [ 2 7] = [ z X 1,870,7600 = [ aaas
Cnmmndity[zl Description E Discount Amount: ‘ .00
|Lat\tude D&10 Intel Pentium [Ceommodity Text Additional Amount: .00
[204s4 [optiplex @280 Intel Pentium [litem Tent Tax Amount: ’7.00
[ [ [ Add Ccommadity Commodity Line Total: [ srasz
[ [ v Distribute Document Commodity Total: 5,184.90
FOAPAL o NSE o 5D
[ e[ 1 Remaining € dity 1 TLAdEER [ override [ Extended [ sisasd
COA Year Index  Fund Orgn Acct Prog Actv Locn Proj [JSuspense [ piscount .00
=] =) = = 4] id] 4] =) 4] [l Additional .00
[17 [os ] [20600  [[as1o0 7159 223 [ [ [ Mrax .o
|— ’_‘ ‘ ‘ | ‘ ‘ | | FOAPAL Line Total: 5,184.90
r ,7‘ ‘ ‘ | ‘ ‘ | | Document Accounting Total: 5.184.90

Screen 9: Change Order - Commodity/Accounting block

Make any necessary changes to the accounting distributions. From here you
can:

e Add new FOAP

o0 From the menu bar select Insert > Record, this will allow you
to add a new FOAP.

0 Next record (arrow down) to blank FOAPAL line and enter
new FOAP.

e Update Extended amount for an existing FOAP
¢ Remove a FOAP by changing the Extended Amount to *0

When ever changes are made to a FOAP, be sure to tab thru all of the fields
for that FOAP, this will allow Banner to recalculate the new totals.

You cannot delete existing accounting distributions from the Change Order by

deleting the line because the FOAP has already been posted by the original
Purchase Order.

8. Next Block to the Balancing/Completion block.
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Completing the Change Order

The Balancing/Completion block displays summary information. The amounts
that display on the Balancing /Completion block reflect summary information for

the entire order (items tha
or added).

If amounts are in balance,
to the main window.

npletion FPACHAR 7.1 (TR

t you did not change in addition to items you changed

click Complete to complete this document and return

NG}

Purchase Order: |Po0D1772

Blanket Order:

Change Sequence Mumber: |1

Yendor:

|12002695 [Dell Marketing LP

Currency: | |

Exchange Rate:
5,184.90

Input Amount:

Converted Amount:

Header

Commodity Accounting Status

Approved Amounts: ‘

5,184.90

5.,184.90 5.,184.90 |BALANCED

Discount Amounts: ‘

00 00 00 |BALANCED

Additional Amounts: ‘

.00 .00 .00 |BALANCED

Tax Amounts:

.00 .00 .00 |BALANCED

Complete: @ In Process:

Screen 10: C

hange Order — Balancing/Completion Block
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Document Change Log

Date Description of Change

July 2005 Document created.

March 16, 2006 Updated entire document for 7.0 content and new
style guide.

July 27,2006 Update deleting line item
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